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Legal Notes

• The information in this document is current as of November,
2007. The information is subject to change without notice. For
actual design-in, refer to the latest publications of NEC
Electronics data sheets or data books, etc., for the most up-to-
date specifications of NEC Electronics products. Not all
products and/or types are available in every country. Please
check with an NEC Electronics sales representative for
availability and additional information.
 

• No part of this document may be copied or reproduced in any form
or by any means without the prior written consent of NEC
Electronics. NEC Electronics assumes no responsibility for any
errors that may appear in this document.
 

• NEC Electronics does not assume any liability for infringement of
patents, copyrights or other intellectual property rights of third
parties by or arising from the use of NEC Electronics products listed
in this document or any other liability arising from the use of such
products. No license, express, implied or otherwise, is granted under
any patents, copyrights or other intellectual property rights of NEC
Electronics or others.
 

• Descriptions of circuits, software and other related information in this
document are provided for illustrative purposes in semiconductor
product operation and application examples. The incorporation of
these circuits, software and information in the design of a customer's
equipment shall be done under the full responsibility of the customer.
NEC Electronics assumes no responsibility for any losses incurred
by customers or third parties arising from the use of these circuits,
software and information.
 

• While NEC Electronics endeavors to enhance the quality, reliability
and safety of NEC Electronics products, customers agree and
acknowledge that the possibility of defects thereof cannot be
eliminated entirely. To minimize risks of damage to property or injury
(including death) to persons arising from defects in NEC Electronics
products, customers must incorporate sufficient safety measures in
their design, such as redundancy, fire-containment and anti-failure
features.
 

• NEC Electronics products are classified into the following three
quality grades: "Standard", "Special" and "Specific".
 

• The "Specific" quality grade applies only to NEC Electronics
products developed based on a customer-designated "quality
assurance program" for a specific application. The recommended
applications of an NEC Electronics product depend on its quality
grade, as indicated below. Customers must check the quality grade
of each NEC Electronics product before using it in a particular
application.
"Standard": Computers, office equipment, communications
equipment, test and measurement equipment, audio and visual
equipment, home electronic appliances, machine tools, personal
electronic equipment and industrial robots.
"Special": Transportation equipment (automobiles, trains, ships,
etc.), traffic control systems, anti-disaster systems, anti-crime
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systems, safety equipment and medical equipment (not specifically
designed for life support).
"Specific": Aircraft, aerospace equipment, submersible repeaters,
nuclear reactor control systems, life support systems and medical
equipment for life support, etc.
 

The quality grade of NEC Electronics products is "Standard" unless otherwise
expressly specified in NEC Electronics data sheets or data books, etc. If
customers wish to use NEC Electronics products in applications not intended by
NEC Electronics, they must contact an NEC Electronics sales representative in
advance to determine NEC Electronics' willingness to support a given application.

(Note)
(1) "NEC Electronics" as used in this statement means NEC Electronics
Corporation and also includes its majority-owned subsidiaries.
(2) "NEC Electronics products" means any product developed or manufactured
by or for NEC Electronics (as defined above).
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Notes for CMOS Devices

1. VOLTAGE APPLICATION WAVEFORM AT INPUT PIN
Waveform distortion due to input noise or a reflected wave may
cause malfunction. If the input of the CMOS device stays in the area
between VIL (MAX) and VIH (MIN) due to noise, etc., the device may
malfunction. Take care to prevent chattering noise from entering the
device when the input level is fixed, and also in the transition period
when the input level passes through the area between VIL (MAX) and
VIH (MIN).
 

2. HANDLING OF UNUSED INPUT PINS
Unconnected CMOS device inputs can result in malfunction. If an
input pin is unconnected, it is possible that an internal input level may
be generated due to noise, etc., causing malfunction. CMOS devices
behave differently than Bipolar or NMOS devices. Input levels of
CMOS devices must be fixed high or low by using pull-up or pull-
down circuitry. Each unused pin should be connected to VDD or
GND via a resistor if there is a possibility that it will be an output pin.
All handling related to unused pins must be judged separately for
each device and according to related specifications governing the
device.
 

3. PRECAUTION AGAINST ESD
A strong electric field, when exposed to a MOS device, can cause
destruction of the gate oxide and ultimately degrade the device
operation. Steps must be taken to stop generation of static electricity
as much as possible, and to quickly dissipate it should it occur.
Environmental control must be adequate. When it is dry, a humidifier
should be used. It is recommended to avoid using insulators that
easily build up static electricity. Semiconductor devices must be
stored and transported in an anti-static container, static shielding
bag or conductive material. All test and measurement tools including
work benches and floors should be grounded. The operator should
be grounded using a wrist strap. Semiconductor devices must not
be touched with bare hands. Similar precautions need to be taken
for PW boards with mounted semiconductor devices.
 

4. STATUS BEFORE INITIALIZATION
Power-on does not necessarily define the initial status of a MOS
device. Immediately after the power source is turned ON, devices
with reset functions have not yet been initialized. Hence, power-on
does not guarantee output pin levels, I/O settings or contents of
registers. A device is not initialized until the reset signal is received.
A reset operation must be executed immediately after power-on for
devices with reset functions.
 

5. POWER ON/OFF SEQUENCE
In the case of a device that uses different power supplies for the
internal operation and external interface, as a rule, switch on the
external power supply after switching on the internal power supply.
When switching the power supply off, as a rule, switch off the
external power supply and then the internal power supply. Use of the
reverse power on/off sequences may result in the application of an
overvoltage to the internal elements of the device, causing
malfunction and degradation of internal elements due to the passage
of an abnormal current. The correct power on/off sequence must be
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judged separately for each device and according to related
specifications governing the device.
 

6. INPUT OF SIGNAL DURING POWER OFF STATE
Do not input signals or an I/O pull-up power supply while the device
is not powered. The current injection that results from input of such
a signal or I/O pull-up power supply may cause malfunction and the
abnormal current that passes in the device at this time may cause
degradation of internal elements. Input of signals during the power
off state must be judged separately for each device and according
to related specifications governing the device.
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Regional Information

Some information contained in this document may vary from country to country. Before
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• Device availability
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• Availability of related technical literature
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Preface

Readers This manual is intended for users who want to understand the functions of the
low voltage starter kit for motor control.

Purpose This manual presents the hardware manual of the low voltage starter kit for motor
control.

Organization This system specification describes the following sections:

• Kit Contents
• Hardware Setup
• Standalone Operation
• Drive and Motor Protection
• Software Setup
• Using the IAR C Compiler and Source Code Debugger
• Download and Debug the Code
• GUI Operation

Legend Symbols and notation are used as follows:

• Weight in data notation: Left is high order column, right is low order
column

• Active low notation: xxx (pin or signal name is over-scored) or /xxx
(slash before signal name)

• Memory map address: High order at high stage and low order at low
stage

Note Additional remark or tip

Caution Item deserving extra attention

Numeric Notation • Binary: xxxx or xxxB
• Decimal: xxxx
• Hexadecimal: xxxxH or 0x xxxx

Prefixes representing powers of 2 (address space, memory capacity):

• K (kilo): 210 = 1024
• M (mega): 220 = 10242 = 1,048,576
• G (giga): 230 = 10243 = 1,073,741,824

 

User's Manual U18220EE4V0UM00 7



Table of Contents

Chapter 1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Chapter 2 Kit Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Chapter 3 Hardware Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Chapter 4 Standalone Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Chapter 5 Drive and Motor Protection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Chapter 6 GUI Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Chapter 7 Programming the Microcontroller . . . . . . . . . . . . . . . . . . . . . . . . . 19

7.1 Progamming with the Microcontroller Board disconnected . . . . . . . . . . . . . . . . . . . . . . . . . . 20

7.2 Progamming with the Microcontroller Board connected . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Chapter 8 Using the IAR Embedded Workbench . . . . . . . . . . . . . . . . . . . . 25

8.1 Software Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

8.2 MC-LVKIT-714 Setup for On-chip Debugging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

8.3 IAR Embedded Workbench Start-up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

8.4 Compiler Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

8.5 Assembler Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

8.6 Linker Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

8.7 Integrated Debugger Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

8.8 Workspace and Project Setup if the example is not compatible with the installed IAR
workbench . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

41

8.9 Build / Rebuild the Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

8.10 Debugging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

8 User's Manual U18220EE4V0UM00



Chapter 1 Introduction

The low-voltage starter kit for motor control (MC-LVKIT-714) is a complete 3-
phase motor control evaluation system for NEC Electronics’ microcontroller
application-specific standard products (ASSP’s) for motor control.

The kit contains all necessary hardware and software to quickly set up and run a
low-voltage brushless DC motor (BLDCM).

Figure 1-1 Motor Control Starter Kit
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Chapter 2 Kit Contents

• MC-78F0714 microcontroller board containing the µPD78F0714
ASSP microcontroller

• MC-I/O interface board. Connects the microcontroller board to the
power module

• Low-voltage power module (MC-PWR-LV) containing the inverter
MOSFET

• BLDC motor
• Pitman N2311 12V motor or
• Ametek 150093-50 24V motor

• FW7362/15 DC power supply
• 20 MHz oscillator (For use with an On Chip Debug Unit)

For information about the electrical characteristics and hardware functions of the
µPD78F0714 microcontroller, refer to µPD78F0714 User’s Manual
(U16928EJ1V0UD00).

For the instruction descriptions, refer to the 78K0 Series Instruction User’s
Manual (U12326E)
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Chapter 3 Hardware Setup

The kit can be purchased as one unit with all three boards connected as shown
below: Replacement board can be ordered separately.

Figure 3-1 MC-LV-KIT-714 Kit Configuration

To attach the motor, connect the phase U, V and W terminals to the J3 connector
block on the MC-PWR-LV power board and the Hall sensor terminals to the J5
connector block on the MC-IO control board.

Table 3-1 Motor Connections

Motor Terminals I/O Board
(MC-IO)

Power Board
(MV-PWR-LV)Connection Pitman Ametek

Phase U Beige Black — J3 - 1

Phase V Red White — J3 - 2

Phase W Orange Red — J3 - 3

Hall sensor 1 Grey Blue J5 - 13 —

Hall sensor 2 Blue Green J5 - 14 —

Hall sensor 3 White Yellow J5 - 7 —

Hall sensor 5VDC Purple Purple J5 - 6 —

Hall sensor GND Black Orange J5 - 5 —

Motor terminal connections are shown in Figure 3-2 and Figure 3-3 .
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Figure 3-2 Motor Phase Connections

Figure 3-3 Hall Sensor Connections

Figure 3-2 and Figure 3-3 - Pitman Motor shown for reference.
See Table 3-1 for equivalent Ametek motor connections.

Chapter 3 Hardware Setup
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Chapter 4 Standalone Operation

For Stand alone use (i.e. without the GUI), please check that the following jumpers
and links are as defined below

Microcontroller Board

• 2JP5 Pins 2 - 7 Shorted , Pins 3 - 5 shorted
• 2JP1 Pins1 - 2 shorted
• 2JP6 Pins 1 - 2 shorted
• 2JP8 Pins 2 - 3 shorted
• 2JP9 Pins 2 - 3 shorted
• 2JP10 Pins 2 - 3 shorted
• 2SB24 shorted

I/O Board

• JP1 Pins 2 - 3 shorted
• JP2 Pins 2 - 3 shorted
• JP3 Pins 2 - 3 shorted
• JP11 Pins 1 - 2 and 3 - 4 shorted
• JP5 Pins 1 - 2 and 3 - 4 shorted

Low Voltage Power Board

• SB24 Open
• SB25 Shorted
• JP2 Shorted

Example software to run the motor is pre-programmed into the microcontroller’s
flash memory. After the motor is connected, the program is ready to run the motor
as soon as the 15VDC power supply is plugged into J6 of the MC-IO board and
power switch SW1 on the MC-PWR-LV power module is turned ON.

When the kit is powered up or reset, the LED displays "SELF", indicating that the
kit is in standalone mode and you can use the pushbuttons and potentiometer on
the MC-IO board to control the motor.

Figure 4-1 Stand Alone Operation

Three seconds after power up, the LED displays the current (start-up) set speed.

Figure 4-2 Initial Speed Display

Note Ametek motor starting speed is 500 RPM
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After power up in standalone mode, the motor can be operated as follows:

1. Press the START/STOP button to run the motor.
2. Turn the potentiometer clockwise to increase the speed of the motor

or counter clockwise to decrease the speed of the motor.
3. The LED will display the actual motor speed calculated from the Hall

sensor interrupts. The display can be toggled between actual and
demanded speed by use of the MODE button

4. Press the FORWARD or REVERSE button to change the rotation
direction.

5. Press START/STOP to stop the motor.

Caution If the potentiometer position is set to higher speeds, and the motor rotation is
suddenly reversed, an error condition may occur due to a timeout or over-current
detection and the motor will stop operating. To reboot, press the RESET switch
on the MC-IO board, adjust the potentiometer to a lower speed and restart.

To control the motor from the Graphical Interface (GUI) from your PC, please refer
to "section 6" .

Chapter 4 Standalone Operation
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Chapter 5 Drive and Motor Protection

The starter kit and the motor are protected against unexpected events such as
overload, motor stall and malfunction of the Hall sensors. If such faults are
detected, the motor stops rotating and the fault conditions are displayed on the
seven-segment LED. For details on the protection functions implemented in
hardware, consult the user’s manual for MC-PWR-LV low-voltage power module.
The sample code software also has built-in fault detection algorithms as an extra
measure of protection. Consult the software manual for details.

In standalone (SELF) mode, the LED displays the following fault conditions:

• Motor over-current: "O – C – "
• Motor stall fault: "– – – –"
• Hall sensor fault: "H A L L"

In the Graphical Interface mode (PC), the LED displays "PC" all the time and the
GUI will displays all fault conditions. Refer to "section 6" for more information.
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Chapter 6 GUI Operation

To operate the motor from the PC GUI, the Hex file for the motor control software
including the GUI interface, will need to be programmed into the Flash memory
of the 78F0714 microcontroller. The complete IAR embedded Workbench project
can be downloaded from the Motor Control starter kit web site.

To program the "hex" file (BLDC_714_GUI.hex) into the microcontroller please
refer to "section 7" .

Once the Graphical Interface program has been programmed ensure that the
jumpers on the microcontroller board are returned to the settings described in
chapter 4 above

It is necessary to locate the following files on to the PC in order to connect to the
starter kit. The two programs should always be located together in the same
directory

• MotorPanel.exe (GUI Application)
• Motor.inf (set up file)

To operate the PC GUI a “Female-Female” RS232 serial cable (with crossover) is
required.
(Not supplied).
Connect the PC serial port to the starter kit J9 DB-9 RS232 connector with an
RS232 serial cable.

The pin connection of the RS232 cable needs to be as follows (crossover)

Table 6-1 GUI RS232 Cable Connections

Signal Name PC Connection Starter Kit connection

Rx Signal Detect (Not Used) Pin 1 Pin 1

Rx Data Pin 2 Pin 3

Tx Data Pin 3 Pin 2

DTE Ready Pin 4 Pin 4

Signal Ground Pin 5 Pin 5

DCE Ready Pin 6 Pin 6

RTS Pin 7 Pin 8

CTS Pin 8 Pin 7

Ring Indicator (Not used) Pin 9 Pin 9

To launch the communication program Run the "MotorPanel.exe" application
program and the following window should open.

1. Select the appropriate COM port on your PC and click OK.

Figure 6-1 PC COM Port Selection
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The GUI will launch if the connection is established:

Figure 6-2 BLDC Motor Control GUI

2. To operate the motor, use the controls in the GUI window The user
has the same controls as described for the “Stand Alone” mode
(Start / Stop, Clockwise / Anti-Clockwise, Speed increase / decrease)

3. It is also possible to change the PID parameters from the GUI
interface. (Please note that changes can only be made when the
motor is stopped) To change the PID parameters click on the tuning
key symbol

Figure 6-3 Launching PID Parameter Window

The tuning window will open allowing the user to change the values of P, I or D
constants:

Figure 6-4 PID Parameter Window

GUI Operation Chapter 6
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The new parameter values will be down loaded to the starter kit into the internal
RAM when the motor is restarted again.

To make the changes permanent, the user will have to modify the definitions in
the original IAR project files (control.h) and then rebuild the project. This requires
a licensed version of either.

IAR Embedded Workbench (Full Version) or IAR Embedded Workbench (Kick
Start Version).

The three PID values that require changing are

#define KP_DEF

#define KI_DEF

#define KD_DEF

Set these parameters to the values shown in the Tuning Window of the GUI.

Chapter 6 GUI Operation
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Chapter 7 Programming the Microcontroller

If the user wishes to modify the program in the 78F0714 device on the
microcontroller board, a Flash Programmer is required (not included in the Starter
Kit).

Two programmers are available

1. PG-FP4 Full Programmer
2. QB Programmer MiniCube 2 - On Chip Debug / Low Cost

Programmer

Figure 7-1 PG-FP4 Programmer

Figure 7-2 QB Programmer (MiniCube2)

The Graphical Interface for either of these programmers can be downloaded from
the NEC Electronics Development tools web site.

In this guide we have shown only the MiniCube2 (QB Programmer).
The interface for the microcontroller board is the same for both programmers.

Note 1. It is easier to remove the Microcontroller board from the starter kit
to program the device. However it is possible to program the device
while connected to the I/O board. The set up of the programmer is
slightly different although the actual programming of the device is
the same. Programming the microcontroller with the board attached
to the kit is described in "section 7.2" of this user guide.

2. Older programmers such as the PG-FPL can still be used with this
device. Please refer to the previous version of this user guide for
details on how to use this programmer.
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7.1 Progamming with the Microcontroller Board
disconnected

• Download the following files
- The MiniCube2 (QB programmer) Flash Programming

Graphical Interface (From the NEC Electronics Tool download
web site)

- The Appropriate IAR Work bench project (with or without the
GUI) (From the NEC Electronics Motor Control Starter Kit web
site)

- Uncompress and Install the QB programmer GUI software (Run
the "SETUP" application)

• Save and uncompress the IAR Workbench project
- For Flash programming, no changes to the jumper settings on

the Microcontroller board are necessary
• Check that the switches on the QB programmer are set as shown

below
- a) Switch M1 / M2 is set to "M2"
- b) Switch 3 - T – 5 is set to "5"

• Then attach the QB programmer to connector 2J2 on the
microcontroller board using the 16-pin cable

Figure 7-3 Microcontroller Board Flash Connection

• Copy the 78F0714 Flash programming parameter file (78F0714.prm)
into the installation directory for the QB programmer program.

$installation path$\....\PG-FPL\PRM

(This file is included with the IAR project download)

Once the Microcontroller board is configured and the programmer connected to
the PC, open the Flash programming Graphical interface "PG-FPL".

Chapter 7 Programming the Microcontroller
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The following Screen should appear. (Note the text may differ after the 1st two
lines)

Figure 7-4 MiniCube 2 Programmer GUI (QB Programmer)

Next the device needs to be set up from the menu follow the following sequence:

Device =>Setup…

Or press the "Spanner" symbol in the ICON taskbar

The following screen should appear:

Programming the Microcontroller Chapter 7
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Figure 7-5 Device Setup

Set the details for the COM port, Speed etc as shown above.

Note Enter your COM port number as this will vary.

Next press the "PRM File Read" button and the following screen should appear.
Select the 78F0714.prm file and press the "Open" button

Figure 7-6 Parameter File Read

Chapter 7 Programming the Microcontroller
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Then press the “"OK" button to return to the main menu system

The text in the main screen should read

> Device Setup
Parameter File Read Pass
>

Next press the select the "HEX" file to be programmed from the Menu

File => Load
Or press the "Load File" symbol in the ICON taskbar

The following screen should open

Figure 7-7 Hex File Selection

Locate the file as shown in the window from the downloaded IAR project.

The file will be located as follows

$saved directory$\BLDC_Hall_714_GUI\Debug\Exe\

Select the file (BLDC_714_GUI.hex) and press the "OPEN" button

This will close the "LOAD" file window. The following should be displayed on the
main screen

> Open Load File
Success read Load file

The Flash programming setup is now complete.

Now press the "AUTOPROCEDURE" button to start the programming sequence

The following sequence should be seen

>AutoProcedure(Epv)
Blank check Block 000: Not blank, Erase need.

Programming the Microcontroller Chapter 7
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Erasing...
Erase Chip : PASS
Program Chip:
10%
20%
30%
40%
50%
60%
70%
80%
90%
100%
PASS
Verify Chip:
10%
20%
30%
40%
50%
60%
70%
80%
90%
100%
PASS
AutoProcedure(Epv) PASS
>

Note The "Verify Chip operation is enabled by setting the "Read Verify after Program"
option in the "Advanced" Tab of the "Device Setup" Window.
The 78F0714 device has now been reprogrammed with the example program
using the graphical interface. To re program the "stand Alone" again follow the
same procedure as above, but download the "SK BLDC_HALL_714" IAR project
instead.
The file to be programmed is "SK BLDC_HALL_714.hex"

7.2 Progamming with the Microcontroller Board
connected

The only difference from the procedure defined above, is that the QB programmer
switches need to be set as shown below

a) Switch M1 / M2 is set to “M2” (78K0)
b) Switch 3 - T – 5 is set to “T” (Target Power Supply)

Connect the QB programmer as described previously and ensure that once the
setup is completed the 15V DC power supply is connected to the starter kit and
switched on.

Chapter 7 Programming the Microcontroller
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Chapter 8 Using the IAR Embedded Workbench

As already explained the example software for use with the starter kit comprises
two versions

• Sensored BLDC control without the Graphical Interface (GUI)
• Sensored BLDC control with the Graphical interface (GUI)

As described above the kit is supplied pre programmed for use in “Stand Alone”
mode.
(This is without the GUI)

The complete example project program for the IAR 78K0 Embedded Workbench
development tool environment can be downloaded from the motor control web
site as detailed in starter kit package (i.e. where this manual was downloaded).

The software is supplied in source format and can be modified as required.

The following sections describe IAR 78K0 embedded Workbench development
tool environment, how to install it on your computer, and how to rebuild and
download executable code to the microcontroller’s flash memory.

Before proceeding with the tools installation, however, refer to all of the
documentation for the starter kit, On Chip Debugger tool and the IAR Embedded
Workbench.
(Please note that a 16Kbyte code limited version is included with the On Chip
Debug unit and can be used to run the example software.)

Please note that a Flash Programmer, On Chip debugging tool or IAR Embedded
workbench are not included in this package. These items are available from your
local NEC Electronics Distributor or contact your local NEC Electronics sales
office.

8.1 Software Installation

1. If a version of the IAR tool is not already installed, then install the IAR
embedded Workbench tool as per the instructions provided by IAR.

2. Ensure that if not already that the example software has been
downloaded from the NEC starter kit web site and "unzipped" into
an suitable location.

The example software can operate on any revision of either the IAR Kick Start or
IAR Full versions. However it may be necessary to define your own project and
workspace. This is described later in this chapter.

8.2 MC-LVKIT-714 Setup for On-chip Debugging

To set up the MC-LVKIT-714 starter kit for debugging, follow the steps below.

1. Disconnect the M-78F0714 micro board by separating it from the
MC-IO board.

2. Remove jumpers 2JP5 2-5, JP5 3-6 and 2JP7 1-2
3. Ensure that link 2SB24 is open
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Figure 8-1 Microcontroller Board OCD Configuration

Figure 8-2 Microcontroller Board OCD Configuration

4. Reconnect the M-78F0714 board to MC-IO board
5. Attach the on-chip debugging emulator’s target connector to 2JP7

on the M-78F0714 and the USB cable to your computer as shown
below.

Chapter 8 Using the IAR Embedded Workbench
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Figure 8-3 OCD Debugger Unit Connection

The MC-78F0714 must be operated at 20 MHz. This requires the use of the
external 20 MHz oscillator supplied with the kit, which needs to be mounted in
the socket inside the OCD unit.
Please refer to the on-chip debugger user’s manual for information about how to
attach the external oscillator.

8.3 IAR Embedded Workbench Start-up

1. Open the IAR workbench. The following Screen should be opened:
(Note the exact display may vary depending on if this is a new
installation)

Using the IAR Embedded Workbench Chapter 8
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Figure 8-4 IAR Workbench Opening Screen

2. Next open the IAR Workspace by following the sequence and
locating and then selecting the appropriate workspace file as shown
below:

File -> Open -> Workspace -> BLDC LVSK 714

Figure 8-5 IAR Workbench Project Selection

Once the Workspace open the display should look something close to that as
shown in Figure 8-6 .
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This shows the workspace where the project is located and has opened either the
BLDC non GUI or BLDC GUI project. The display shows the following project files

• Left Hand side window – Project File (Source. Header, Map etc)
• Bottom Build Debug messages when the project is re built or the

debugger is active
• The main centre display shows any open files in a tabbed form. The

file can be viewed by selecting the relevant Tab in the wind

Any of the files shown can be opened by double clicking on the file in the
"Project" (left hand side) window. Debugging windows are described later.

Figure 8-6 Workspace & Project open screen

3. The build options for the project can then be set or changed using
the following menus. The build options are entered as shown in
Figure 8-7 below, then ensure all the options are as shown in Figure
8-8 to Figure 8-11 below.

Using the IAR Embedded Workbench Chapter 8
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Figure 8-7 Project build options

Figure 8-8 General Options – Setting the Target Device
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Figure 8-9 General Options – Setting the Output Locations

Figure 8-10 General Options – Selecting the C-Library
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User's Manual U18220EE4V0UM00 31



Figure 8-11 General Options – Setting the Stack and Heap

8.4 Compiler Options

Figure 8-12 Compiler Options – Language Settings

Chapter 8 Using the IAR Embedded Workbench
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Figure 8-13 Compiler Options – Optimisation

Figure 8-14 Compiler Options – Output Set for Debug
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Figure 8-15 Compiler Options – Compiler Listings

Figure 8-16 Compiler Options – Pre Processor Settings

Note All other Compiler Options settings can be remain as the default settings.
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8.5 Assembler Options

Figure 8-17 Assembler Options – Language Settings

Figure 8-18 Assembler Options – Output set for Debug
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Figure 8-19 Assembler Options – Listings

Note All other Assembler Options can be left as the default setting.
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8.6 Linker Options

Figure 8-20 Linker Options – Primary File Output

Figure 8-21 Linker Options – Secondary File Output
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Figure 8-22 Linker Options – Diagnostic settings

Figure 8-23 Linker Options – Generate MAP File Output
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Figure 8-24 Linker Options – Linker Command File Selection

Note The Linker Control File must match the device selected.
The remainder of the Linker setup can be left as the default setting.

8.7 Integrated Debugger Selection

Note The Extra Option section can be ignored.
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Figure 8-25 Integrated Debugger Selection

Figure 8-26 Integrated Debugger - Plug-in Selection
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8.8 Workspace and Project Setup if the example is not
compatible with the installed IAR workbench

• Set a new workspace
File -> New -> Workspace

• Create a new Project
Project -> Create New Project -> Select "Empty Project" -> "OK"

Enter a project name and set the location for the project
(This can be the same location as the downloaded example software
or a new location)

• Add the Source files to the project
• C Source Files

Project -> Add Files

Locate and select all the C source files
• Main.c
• Fault.c
• Carrier.c

Press "OPEN"

• Repeat the operation for the Assembler file
Project -> Add Files

When the Selection window opens select
Files of Type -> Assembler Files

Select the assembler file
• SEC_OPT.s26"

Press OPEN"

All these file should now appear in the Project Window (Left Hand Side of the IDE),
as shown previously.

8.9 Build / Rebuild the Project

To build the project press the “make” icon in the task bar as shown below:

Figure 8-27 Make Button

The build results and any errors or warnings will be displayed in the Messages
window at the bottom of the IDE. These should be corrected before moving on to
the Debugging section.

Using the IAR Embedded Workbench Chapter 8
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8.10 Debugging

Once the project has been built without errors the user can now start the
debugging session.

This is done by pressing the "Debug" icon in the task bar.

Figure 8-28 Start the Debug Session

The debugger will connect to the OCD unit and download the code to the Flash
memory on the microcontroller board.

Once downloaded the debugging window will open as shown below in Figure
8-29 .

Note The IAR embedded Workbench provides an integrated debugger, so the
debugging window opens as part of the IDE.

If the debugger is run for the first time in a new project the following set up window
will open. This is to set the basic function of the debugging hardware (i.e. Mini
Cube or IECube etc.).

Chapter 8 Using the IAR Embedded Workbench
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Figure 8-29 Debugging – Initial Hardware Setup

Ensure that the settings are as defined above.

Note If the Main Clock shows the “Clock board” detected, then ensure that this is
selected.
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Figure 8-30 Integrated Debugger - Main Window

Figure 8-31 Debugger Task Bar Icons
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Figure 8-32 Debug Menus
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Figure 8-33 Debug Views Windows

Figure 8-34 Emulator Debug Options

Note The "Live Watch" does not operate in real time on the On Chip Debug Unit.
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